
RNA 9000 Purity & Integrity 试剂盒
适用于 PA 800 Plus Pharmaceutical Analysis 系统

应用指南

RUO-IDV-05-13437-ZH-C 2023 年 5 月



本文件供已购买 SCIEX 设备的客户在操作此 SCIEX 设备时使用。本文件受版权保护，除非 SCIEX 书
面授权，否则严禁对本文件或本文件任何部分进行任何形式的复制。

本文中所介绍的软件依据许可协议提供。除许可证协议中特别准许的情况外，在任何媒介上复制、修改
或传播本软件均为违法行为。此外，许可协议禁止出于任何目的对本软件进行分解、逆向工程或反编
译。质保条款见文中所述。

本文件的部分内容可能涉及到其他制造商和/或其产品，其中可能有一些部件的名称属于各自所有者的注
册商标和/或起到商标的作用。这些内容的使用仅仅是为了表明这些制造商的产品由 SCIEX 提供以用于
整合到 SCIEX 的设备中，并不意味 SCIEX 有权和/或许可来使用或允许他人使用这些制造商的产品和/
或允许他人将制造商产品名称作为商标来进行使用。

SCIEX 的质量保证仅限于在销售或为其产品发放许可证时所提供的明确保证，而且是 SCIEX 的唯一且
独有的表述、保证和义务。SCIEX 不作任何其他形式的明确或隐含的质量保证，包括但不限于特定目的
的适销性或适用性的保证，不论是法规或法律所规定、还是源于由贸易洽谈或商业惯例，对所有这些要
求均明确免责，概不承担任何责任或相关后果，包括由于购买者的使用或由此引起的任何不良情况所造
成的间接或从属损害。

仅供研究使用。请勿用于诊断过程。

本文提及的商标和/或注册商标，包括相关标志，是 AB Sciex Pte. Ltd. 或各自所有者在美国和/或某些其
他国家的财产(参见 sciex.com/trademarks)。
AB Sciex™ 的使用经过许可。

采用国内外组件在美国制造。

© 2023 DH Tech. Dev. Pte. Ltd.

EC 授权人员 AB Sciex Netherlands B.V.
1e Tochtweg 11,
2913LN Nieuwerkerk aan den Ijssel
Netherlands

爱博才思有限公司 AB Sciex Pte. Ltd.
Blk33, #04-06 Marsiling Industrial Estate Road 3
Woodlands Central Industrial Estate, Singapore 739256

RNA 9000 Purity & Integrity 试剂盒 适用于 PA 800
Plus Pharmaceutical Analysis 系统
2/47

应用指南
RUO-IDV-05-13437-ZH-C



目录

RNA 9000 Purity & Integrity 试剂盒 ....................................................................................... 5
安全性 ..................................................................................................................................5
预期用途 .............................................................................................................................. 5
介绍 ......................................................................................................................................5

工作流程 ......................................................................................................................... 5
所需设备和材料 ....................................................................................................................6

储存条件 ......................................................................................................................... 7
客户提供的设备和用品 ....................................................................................................8
所需检测器 ......................................................................................................................8
所需卡盒或毛细管 ...........................................................................................................8
调节毛细管 ......................................................................................................................9

方法和序列 ...........................................................................................................................9
制备样本 .............................................................................................................................. 9

处理 RNA 的最佳做法 ..................................................................................................... 9
制备 ssRNA Ladder...................................................................................................... 10
制备 RNA 样本 ..............................................................................................................10

准备 PA 800 Plus 系统 ....................................................................................................... 11
安装 LIF 检测器 .............................................................................................................11
清洁接口块 .................................................................................................................... 11
安装卡盒并校准检测器 .................................................................................................. 11
装载缓冲剂托盘 .............................................................................................................12
装载样本托盘 ................................................................................................................ 14

运行样本 ............................................................................................................................ 16
获得最佳结果的提示 ..................................................................................................... 16
创建示例仪器 ................................................................................................................ 16
创建示例项目 ................................................................................................................ 17
创建序列并开始运行 ..................................................................................................... 18

废物处置 ............................................................................................................................ 22
储存卡盒 ............................................................................................................................ 22

卡盒储存时间不超过 24 小时 ........................................................................................ 22
卡盒储存时间超过 24 小时 ............................................................................................22
储存后准备卡盒 .............................................................................................................22

分析数据 ............................................................................................................................ 23
分析 ssRNA Ladder 的数据 .......................................................................................... 23
制定接受度标准的要领 ..................................................................................................24

故障排除 ............................................................................................................................ 24

A 有害物质信息 ...................................................................................................................... 33

B 方法 .....................................................................................................................................34
毛细管调节方法 ..................................................................................................................34

应用指南
RUO-IDV-05-13437-ZH-C

RNA 9000 Purity & Integrity 试剂盒 适用于 PA 800
Plus Pharmaceutical Analysis 系统

3/47



分离方法 ............................................................................................................................ 36
关闭方法 ............................................................................................................................ 37
毛细管冲洗方法 ..................................................................................................................39

C 校准 LIF 检测器 ...................................................................................................................41
用于 LIF 检测器校准的 CCF 值 ..........................................................................................45

联系我们 ................................................................................................................................. 46
客户培训 ............................................................................................................................ 46
在线学习中心 ..................................................................................................................... 46
购买用品和试剂 ..................................................................................................................46
SCIEX 支持 ........................................................................................................................46
网络安全 ............................................................................................................................ 46
文档 ....................................................................................................................................46

目录

RNA 9000 Purity & Integrity 试剂盒 适用于 PA 800
Plus Pharmaceutical Analysis 系统
4/47

应用指南
RUO-IDV-05-13437-ZH-C



RNA 9000 Purity & Integrity 试剂盒

RNA 9000 Purity & Integrity 试剂盒包含用于样本制备的试剂和用品，以及按大小分辨 RNA 碎
片和对 RNA 制备中可能存在的异质性和杂质进行量化的方法。

本文档提供了使用 RNA 9000 Purity & Integrity 试剂盒进行样本制备的说明。它还提供了使用
PA 800 Plus 软件进行数据采集和数据分析的说明。

使用此应用程序指南中的信息作为起点。根据需要，更改进样时间、电压、进样类型或其他参
数，以寻找适合您需要的最佳条件。

注释: 有关系统安全使用的说明，请参阅文档：《系统概要指南》。

安全性
关于妥善处理材料和试剂的信息，请参阅可从 sciex.com/tech-regulatory 获得的安全数据表
(SDS)。始终遵循标准实验室安全规范。关于有害物质信息，请参阅以下章节：有害物质信
息。

预期用途
RNA 9000 Purity & Integrity 仅供实验室使用。

介绍
RNA 9000 Purity & Integrity 试剂盒专为从事新一代 RNA 疗法工作的生物制药科学家设计。该
试剂盒具有很高的分析分辨率，可帮助降低方法复杂性，简化可转移性。该试剂盒已在 PA
800 Plus 和 BioPhase 8800 系统上进行了验证。

方法学涉及 RNA 样本的热变性以及随后立即在冰水浴中进行的冷却。这样将使核酸形成的结
构在分离过程中具有最均匀的淌度。

RNA 样本在无涂层熔融石英毛细管中按大小分离，该毛细管包含可更换的聚合物凝胶，可提
供筛分选择性，同时限制计数器电渗流 (EOF)。在试剂制备过程中，向聚合物凝胶基质添加荧
光标记染料 SYBR™ Green II RNA Gel Stain1 。该染料优先与 RNA 分子结合，以便在分离过
程中通过激光诱导荧光 (LIF) 检测到 RNA。

工作流程

表 1 RNA 9000 Purity & Integrity 试剂盒工作流程

步骤 目的 请参阅

1 制备浓度为 50 ng/mL 到 50 μg/mL 的
RNA 样本。

实验室的 RNA 制备程序。

1 SYBR™ 是 Life Technologies Corporation 的商标。SYBR™ Green II RNA Gel Stain 不可转售。
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表 1 RNA 9000 Purity & Integrity 试剂盒工作流程 (续)

步骤 目的 请参阅

2 （可选）用 Sample Loading Solution 或
不含核酸酶的水稀释 ssRNA Ladder，
在 70 °C 下变性 5 分钟，然后立即冷
却。

制备 ssRNA Ladder

3 用 Sample Loading Solution 或不含核酸
酶的水稀释每份 RNA 样本，在 70 °C
下变性 5 分钟，然后立即冷却。

制备 RNA 样本

4 安装 LIF 检测器。 安装 LIF 检测器

5 装载样本托盘。 装载样本托盘

6 安装卡盒。 安装卡盒并校准检测器

7 制备凝胶缓冲剂并装载缓冲剂托盘。 装载缓冲剂托盘

8 对于 PA 800 Plus 软件用户，创建 RNA
9000 仪器和项目。

创建示例仪器 和 创建示例项目

9 在 PA 800 Plus 软件中，创建序列，然
后开始运行。确保该序列以 关闭方法 -
RNA 9000 方法结束。

创建序列并开始运行

10 运行之后，储存卡盒。 储存卡盒

11 分析数据。 分析数据

所需设备和材料

注释: 对于具有重新订购产品号的组分，有时重新订购数量与试剂盒中的数量不同。

注释: RNA 9000 Purity & Integrity 试剂盒 (PN C48231) 分成两部分包装：核酸纯度和完整性
范围扩展试剂盒 (PN 5087900) 和 ssRNA Ladder (0.05-9 kb) (PN 5088699)。任何一部分都不
能单独订购。

注释: RNA 9000 Purity & Integrity 试剂盒 (PN C48231) 中的 ssRNA Ladder 与其他试剂盒组
件分开发货。

表 2 RNA 9000 Purity & Integrity 试剂盒 (PN C48231)

组分 数量 重新订购产品号

核酸纯度和完整性范围扩展试剂盒 (PN 5087900) 不适用

Acid Wash/Regenerating Solution (0.1 M HCl) (100 mL) 1 不适用

CE Grade Water (140 mL) 2 C48034

LIF Performance Test Mix (20 mL) 1 726022
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表 2 RNA 9000 Purity & Integrity 试剂盒 (PN C48231) (续)

组分 数量 重新订购产品号

Nucleic Acid Extended Range Gel (140 mL) 2 不适用

SYBR™ Green II RNA Gel Stain2 (500×) (0.11 mL) 7 不适用

ssRNA Ladder (0.05-9 kb) (PN 5088699) 不适用

ssRNA Ladder（0.05 kb 至 9 kb）(70 μL)（分开发货） 2 不适用

表 3 来自 SCIEX 的其他用品

组分 数量 产品号

（可选）Capillary Performance Run Buffer A 1 338426

无涂层熔融石英毛细管（内径 50 μm × 长 67 cm） 1 338451

毛细管卡盒，空 1 144738

毛细管卡盒，预装 1 A55625

滤光片，520 nm 发射滤光片 1 144940

LIF 卡盒小孔塞子组件 1 721125

LIF 卡盒导针组件 1 721126

PCR 微型瓶 (200 µL) 100 144709

Sample Loading Solution 6 mL 608082

通用瓶盖，蓝色 100 A62250

通用瓶 100 A62251

表 4 其他必需试剂或用品

描述 供应商 产品号

孔径滤膜为 0.45 μm 的 Acrodisc 32 mm 注射器过滤器 Pall 4654

Luer-Lok 尖端一次性注射器 (10 mL) BD 309604

（可选）不含核酸酶的水 (10 × 2 mL) Integrated DNA
Technologies

11-04-02-01

（可选）RNaseZap RNase Decontamination Solution
(250 mL)

Thermo Fisher
Scientific

AM9780

储存条件

• 收到后，将下列组分储存在 2 °C 至 8 °C 条件下：

2 SYBR™ 是 Life Technologies Corporation 的商标。SYBR™ Green II RNA Gel Stain 不可转售。
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• Nucleic Acid Extended Range Gel

• LIF Performance Test Mix

• 收到后，立即将 SYBR™ Green II RNA Gel Stain3 包在铝箔中以减少 SYBR™ Green II RNA
Gel Stain 光漂白，然后储存在 -35 °C 至 -15 °C 条件下。

• 收到后，将 ssRNA Ladder 储存在 -35 °C 至 -15 °C 条件下。

• 试剂盒中的其他物品可储存在室温条件下。

客户提供的设备和用品

• 无粉手套，推荐氯丁橡胶或丁腈手套

• 护目镜

• 实验服

• PCR 管，0.2 mL 平盖无核酸酶（VWR USA PN 20170-012 或 VWR EUR PN 732-0548）

• 台式迷你离心机

• 微型离心机或同等产品，以及无核酸酶微量离心管

• 漩涡混合器

• 移液器和适当的无核酸酶吸头

• 37 °C 至 100 °C 温度的水浴或加热器

• 分析天平

• 冰

所需检测器

需要激发波长为 488 nm 的激光诱导荧光 (LIF) 检测器和 520 nm 发射滤波片以及进行校准所
需的用品。校准用品包括：

• LIF Performance Test Mix，随试剂盒 提供

• CE Grade Water，随试剂盒提供

所需卡盒或毛细管

小心: 潜在的错误结果。如果毛细管与 RNA 9000 Purity & Integrity 试剂盒一起使用，则不要
将同一毛细管用于其他用途。混用不同的缓冲剂和样本类型可能会导致样本残留、非特异性结
合和分离不佳。

以下任一种：

• 预装卡盒 (PN A55625)

• 毛细管卡盒 (PN 144738) 以及毛细管，裸熔融石英，50 µm 内径 (PN 338451)

3 SYBR™ 是 Life Technologies Corporation 的商标。SYBR™ Green II RNA Gel Stain 不可转售。
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调节毛细管

小心: 潜在的错误结果。切勿使用碱性溶液清洗毛细管，因为该溶液可能会使毛细管壁出现负
电离，导致其与样本发生非特异性相互作用。这些相互作用可能会导致分离不佳和样本降解。

• 首次使用毛细管之前，使用 调节方法 - RNA 9000 方法调节毛细管。

方法和序列
从 sciex.com/products/methods 下载方法和序列。这些方法和序列也可通过 32 Karat 软件手
动创建。请参阅以下章节：方法。

将方法保存到 PA 800 Plus 控制器：C:\32Karat\projects\RNA 9000\Method。
将序列保存到：C:\32Karat\projects\RNA 9000\Sequence。
在发布时，下列方法和序列可从 SCIEX 网站获得：

• 方法：

• 调节方法 - RNA 9000：调节毛细管。

• 分离方法 - 电动力学进样 - RNA 9000：利用电动力学进样分离样本。

• 关闭方法 - RNA 9000：在序列结束时清洁毛细管，并关闭光源。

• 毛细管冲洗 - RNA 9000：冲洗毛细管。为了节省调节毛细管后的时间，在序列中用此方
法替换调节方法 - RNA 9000。

• 分析 - RNA 9000 - ssRNA 梯：包含帮助进行 ssRNA Ladder 分析的默认积分参数和命
名峰。

• RNA 9000 测试序列 - 电动力学进样：分离方法使用动力学进样的序列。

制备样本

处理 RNA 的最佳做法

控制 RNA 酶污染对于成功地分析 RNA 至关重要。在 ssRNA Ladder 或 RNA 样本分离之前必
须采取预防措施以确保 RNA 完整性。RNA 酶普遍存在于人类皮肤上、汗水和唾液以及细菌和
真菌孢子中，因此在实验室环境中无处不在。正确的实验室程序将有助于控制因 RNA 酶而造
成的 RNA 降解。

1. 处理 RNA 样本时，始终佩戴手套并且经常更换。

2. 指定无 RNA 酶的实验室区域，并对工作台表面、实验室支架和微量移液器使用
RNaseZap RNase Decontamination Solution 或 MP Bio RNase Erase Decontamination
Solution 之类的 RNA 酶去污试剂。另外，使用能够进行紫外线消毒的实验室仪器以帮助
控制 RNA 酶污染。

3. 指定专门用于 RNA 的移液器，并使用经过无核酸酶认证的过滤移液器吸头以减少交叉污
染。

4. 对于接触 RNA 的任何物品，都应使用无核酸酶塑料进样瓶和实验室器皿。在添加任何
RNA 之前，采取遮挡措施并在气流受限的区域中操作以防止塑料器皿受到环境污染。
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5. 在 RNA 样本制备过程中，使用不含核酸酶的水之类的试剂。在 RNA 样本制备过程中使
用 Sample Loading Solution 或去离子甲酰胺有助于获得可使 RNA 稳定并防止 RNA 因
RNA 酶而降解的环境。

注释: CE Grade Water 未认证为不含核酸酶。

制备 ssRNA Ladder
注释: 使用 ssRNA Ladder 作为估测未知 RNA 样本大小的定性参考。它不适合作为定量标准
品。

1. 制备 ssRNA Ladder。

a. 如果是初次运行，请从冰箱中取出一瓶 ssRNA Ladder，然后置于冰上使其解冻。

b. 使用漩涡混合器粗略混合几秒钟，然后使用离心机旋转进样瓶几秒钟，以使溶液聚集
在进样瓶底部。

c. 按 8 μL 等份将溶液量取到不含核酸酶的 PCR 瓶中。

d. 预留一份，然后将其余等份储存在 –35 °C 至 –15 °C 的条件下。

2. 使用一份 8 μL 的 ssRNA Ladder 等份。如果已冷冻，则使用之前放在冰上解冻。

3. 对于每 50 μL 的 RNA 样本，向 48 μL 的 Sample Loading Solution 或不含核酸酶的水中
添加 2 μL 的 ssRNA Ladder。

4. 在 70 °C 条件下加热样本 5 分钟。

5. 5 分钟后，立即将混合物放在冰水浴中冷却至少 2 分钟。

注释: 快速冷却可使 RNA 形成能够提供最佳分离结果的结构。

6. 将微型瓶置于通用瓶中，然后将通用瓶放进样本托盘中。

7. 使用移液器将 50 μL 至 200 μL 冷却后的 RNA 溶液添加到微型瓶，然后给通用瓶盖上蓝
色瓶盖。

8. 将样本托盘放入系统。确保样本室温度设置为 10 °C。

注释: 如果 LIF 激光器未预热或检测器未校准，则不要将样本托盘放入系统。相反，在激
光器预热时或执行校准时应将托盘存放在 2 °C 至 8 °C 条件下，然后再将样本托盘放入系
统。

制备 RNA 样本

1. 在冰上解冻 RNA 等份样本。

保持样本冷却以防止 RNA 降解。

2. 使用 Sample Loading Solution 或不含核酸酶的水制备 50 ng/mL 到 50 μg/mL 的 RNA 样
本。

建议 RNA 浓度为 1 μg/mL 至 5 μg/mL。
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注释: 要使用更高的样本浓度，在分离方法的 LIF Detector Initial Conditions 选项卡中将
Dynamic range 从 100 升高至 1,000。

3. 在 70 °C 条件下加热样本 5 分钟。

4. 5 分钟后，立即将混合物放在冰水浴中冷却至少 2 分钟。

注释: 快速冷却可使 RNA 形成能够提供最佳分离结果的结构。

5. 将微型瓶置于通用瓶中，然后将通用瓶放进样本托盘中。

6. 使用移液器将 50 μL 至 200 μL 冷却后的 RNA 溶液添加到微型瓶，然后给通用瓶盖上蓝
色瓶盖。

7. 将样本托盘放入系统。确保样本室温度设置为 10 °C。

注释: 如果 LIF 激光器未预热或检测器未校准，则不要将样本托盘放入系统。相反，在激
光器预热时或执行校准时应将托盘存放在 2 °C 至 8 °C 条件下，然后再将样本托盘放入系
统。

准备 PA 800 Plus 系统
使用本节中的程序准备 PA 800 Plus 系统以采集数据。

本节中的程序假定系统已正确安装并初始化。

提示! 为了节省时间，在开始运行之前 30 分钟开启光源，以使其预热。

安装 LIF 检测器

1. 关闭 PA 800 Plus 系统，然后安装 LIF 检测器。请参阅文档：《系统维护指南》。

2. 打开系统。

3. 开启激光器，使其预热至少 30 分钟。

清洁接口块

小心: 潜在的系统损坏。切勿让凝胶聚积在电极、开口杆、毛细管端和接口块上。凝胶累积可
能造成毛细管损坏、电极弯曲、进样瓶堵塞或进样缺失。

每次使用后清洁电极、开口杆、毛细管端和接口块，或在更换化学物质时清洁。如需详细说
明，请参阅文档：《系统维护指南》。

凝胶缓冲剂非常粘稠，如不定期彻底清洁会聚集在系统中。

安装卡盒并校准检测器

注释: 为了该确保分析结果始终一致，SCIEX 建议每次将其安装到 PA 800 Plus 系统中时校准
检测器。另外，更换了卡盒中的毛细管或安装了不同的卡盒后也应校准检测器。

1. 从卡盒箱中取出卡盒，如有必要，安装毛细管。
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2. 从卡盒中取出小孔，然后将 LIF 小孔和导针安装到 LIF 检测器上。请参阅文档：《系统维
护指南》。

3. 在 PA 800 Plus 系统中安装卡盒。请参阅文档：《系统维护指南》。

4. 校准检测器。

使用 Calibration 向导，它可从 Instrument Configuration 对话框调用（在 32 Karat 软件
中）。如需详细说明，请参阅以下章节：校准 LIF 检测器。

在 Calibration 向导第二步，使用下表中的值。

注释: Target RFU 为 40，因此来自 PA 800 Plus 系统的信号强度与来自 BioPhase 8800
系统的信号几乎完全相同。这用于确保可转移性。

表 5 校准参数

检测器通道 1

目标 RFU 40

毛细管大小

内径 50 µm

总长度 30 cm 或 50 cm，取决于毛细管的长度

装载缓冲剂托盘

小心: 潜在的系统损坏。向任何瓶中加注的液体量切勿超过 1.8 mL。另外，切勿使废液瓶中汇
集的液体超过 1.8 mL。如果瓶中的液体超过 1.8 mL，则可能会损坏压力系统。

注释: 为防止出现气泡，切勿摇晃或用力混合凝胶。气泡可能会造成分离问题。

注释: SYBR™ 是 Life Technologies Corporation 的商标。SYBR™ Green II RNA Gel Stain 不
可转售。

1. 向锥形试管中添加下表指定的试剂，然后轻轻地倒转试管至少 20 次。

在倒转试管时，确保未形成气泡。

小心: 潜在的错误结果。请勿提前制备凝胶缓冲剂。SYBR™ Green II RNA Gel Stain（凝
胶缓冲剂中）在存储期间性能可能下降，导致峰的强度降低。

表 6 凝胶缓冲剂（含有 SYBR™ Green II RNA Gel Stain 的 Nucleic Acid Extended
Range Gel）

试剂 用于 1 至 8 份
样本

用于 9 至 16
份样本

用于 41 至 48
份样本

Nucleic Acid Extended Range Gel 5 mL 10 mL 30 mL

SYBR™ Green II RNA Gel Stain 10 μL 20 μL 60 μL
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注释: 凝胶缓冲剂和染料混合物在文档的其余部分称为“凝胶缓冲剂”。

提示! 将含有所制备凝胶缓冲剂的瓶包在铝箔中，以减少 SYBR™ Green II RNA Gel Stain
光漂白。

2. 使用 0.45 μm Acrodisc 注射器过滤器和 Luer-Lok 注射器过滤凝胶缓冲剂。

3. 按照下图所示，将 16 个通用瓶放进缓冲剂托盘中。每行足够运行至少八次。

注释: 分离方法已被编程设定为运行八次后递增。切勿重复使用进样瓶或盖帽，因为会可
能被干燥的凝胶和其他化学品污染。进样瓶或盖帽仅可一次性使用。

图 1 16 个样本的缓冲剂托盘布局

注释: 如果样本数量少于 8 个，仅填充第 1 行。

4. 按照下表中所示填充进样瓶。填充每个进样瓶之后，盖上蓝色瓶盖。请参阅图：图 2。

表 7 需要准备的进样瓶

图 1 中的标签 进样瓶数量 容积/进样瓶
(mL)

试剂

水 10 1.5 CE Grade Water

凝胶 6 1.5 含有 SYBR™ Green II RNA Gel Stain 的
凝胶缓冲剂

HCl 2 1.5 Acid Wash/Regenerating Solution

废弃物 6 1.0 CE Grade Water
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图 2 通用瓶和瓶盖设置

项目 描述

1 通用瓶盖

2 最大加注线

3 通用瓶

装载样本托盘

1. 将每个微型瓶置于通用瓶中，然后将通用瓶放进样本托盘中。请参阅图：图 3。
位置 A1 用于 ssRNA Ladder。其他样本使用其他位置。
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图 3 样本托盘布局

2. 向微型瓶中添加样本。对于每份样本：

a. 向微型瓶中转移 50 µL 到 200 μL 样本。

b. 在通用瓶上盖好蓝色盖帽。请参阅图：图 4。

图 4 样本瓶安装

项目 描述

1 通用瓶盖
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项目 描述

2 微型瓶

3 通用瓶

4 通用瓶内的微型瓶

运行样本

获得最佳结果的提示

SCIEX 在一系列温度下测试了 ssRNA Ladder 的分离性能以及其他特征。在分离方法中使用
30 °C，因为在该温度下获得了最佳的总体结果。

如果需要最大化特定特征，也可以使用其他温度。请参阅表格：表 8。

表 8 设置毛细管温度的要领

毛细管温度 (°C) 毛细管运行寿命 9 kb 峰迁移时间
(min)

不同 RNA 长度的最佳分辨率

3 kb 至 5 kb ≥ 5 kb

25 最高 ~21

30 较高 ~20

35 中 ~19

40 低 ~17

注释: 毛细管运行寿命（可以执行的进样次数）取决于样本和分离方法。上表显示了性能如何
根据毛细管温度而变化。通常，较低的温度可增加毛细管运行寿命。

使用冲洗方法

冲洗方法随试剂盒的其他方法提供。

为了节省调节毛细管后的时间，在序列中用 毛细管冲洗 - RNA 9000 方法替换 调节方法 -
RNA 9000 方法。冲洗方法的时间比调节方法短大约 30 分钟。

创建示例仪器

注释: 如果使用 PA 800 Plus 软件进行数据采集和分析，则需要执行以下程序。如果使用
32 Karat 软件，则不需要执行此程序。

此程序需要对 32 Karat 软件拥有管理权限的用户的用户名和密码。

如需详细说明，请参阅文档：32 Karat 软件帮助或方法开发指南。

1. 双击桌面上的 32 Karat 图标。

2. 单击 Tools > Enterprise Login，输入用户名和密码，然后单击 Login。
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3. 单击 Tools > System Administration Wizard。

图 5 选择 Administration Wizard 窗口

4. 单击 Instrument，然后单击 Next。

5. 按照向导中的说明创建仪器。提示输入仪器名称时，键入 RNA 9000。
PA 800 plus System Configuration 对话框随即打开。

6. 单击 LIF Detector ，然后单击 OK。

7. 执行以下任一操作：

• 如果系统连接到控制器且已打开，则单击 Auto Configuration。

• 如果系统未连接到控制器或已关闭，则在 Configured modules 列表中，右键单击
LIF Detector，并选择 Open。确保托盘配置正确，然后单击 OK。

8. 单击 OK。
PA 800 plus System Configuration 对话框随即关闭。

创建示例项目

注释: 如果使用 PA 800 Plus 软件进行数据采集和分析，则需要执行以下程序。如果使用
32 Karat 软件，则不需要执行此程序。

此程序需要对 32 Karat 软件拥有管理权限的用户的用户名和密码。

1. 双击桌面上的 32 Karat 软件图标。

如果 32 Karat 软件已打开，则关闭打开的任何仪器窗口。
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2. 单击 Tools > Enterprise Login，输入用户名和密码，然后单击 Login。

3. 单击 Tools > System Administration Wizard。

图 6 选择 Administration Wizard 窗口

4. 单击 Project，然后单击 Next。

5. 按照向导中的说明创建项目。提示输入项目名称时，键入 RNA 9000。
确保为该项目指定用户。

如需详细说明，请参阅文档：32 Karat 软件帮助或系统管理指南。

6. 如果需要，则从 SCIEX 网站下载方法和序列文件。请参阅以下章节：方法和序列。

7. 将方法复制到项目的方法文件夹。默认情况下，该文件夹为
C:\32Karat\projects\RNA 9000\Method。

8. 将序列复制到项目的序列文件夹。默认情况下，该文件夹为
C:\32Karat\projects\RNA 9000\Sequence。

创建序列并开始运行

1. 双击桌面上的 PA 800 Plus 软件图标以打开 PA 800 Plus 软件。
PA 800 Plus 窗口打开

2. ，单击窗口右上角的  (Run)。
Instrument Status and Direct Control 页面打开。
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图 7 Instrument Status and Direct Control 窗口

3. 单击  (Describe)。

4. 在 Application 列表中，单击 RNA 9000。在 Sequence 列表中，单击 Browse，然后浏
览到 RNA 9000 测试序列 - 电动力学进样 序列。按提示键入用户名和密码。
页面更新以显示所选的序列，序列中的所有行指定为样本。

5. 单击第一行将其选中，然后单击 Rows 区域中的  (Control)。
第一行包含 ssRNA Ladder。
序列第一行的 Type 列中的图标变成正方形。

6. 单击最后一行（包含关闭方法 - RNA 9000 方法）将其选中，然后单击 Rows 区域中的

 (Always)。
序列的 Type 列中的图标变成三角形。
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图 8 Describe sequence rows and columns 窗口

7. 在窗口右下角，单击  (Save)，然后单击  (Finish)。

8. 在 Number of samples 字段中，单击箭头按钮设置要运行的样本数量。

图 9 设置样本数量

随着样本数量变化，右侧的缓冲剂和样本托盘图片相应地更新，以显示要运行的正确进样
瓶数量及其位置。例如，在 图 1 中，八个样本需要一个试剂行。16 个样本需要两个试剂
行。
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图 10 托盘图

9. 如果尚未装载缓冲剂和样本托盘，则单击  (Load)，在 PA 800 Plus 系统中装载
缓冲剂和样本托盘，然后关闭门。

10. 单击  (Next)，然后单击 Yes - run now。

图 11 样本已装载提示
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图 12 数据采集期间的 PA 800 软件

废物处置

警告! 生物危害或有毒化学品危险。在处置化学品、瓶和盖帽和残留的制备样本
时，请遵照当地规定。其可能包含限用化合物和生物危害性试剂。

储存卡盒

卡盒储存时间不超过 24 小时

1. 使用关闭方法清洁毛细管。

关闭方法向毛细管中灌注 CE Grade Water，并将卡盒温度降低至 15 °C。

2. 将卡盒在系统中储存最多 24 小时，并且毛细管端应浸没在装有 CE Grade Water 的瓶
中。

卡盒储存时间超过 24 小时

1. 使用关闭方法清洁毛细管。

2. 从系统上取下卡盒。

3. 将卡盒放在卡盒储存箱中，毛细管端应浸没在装有 CE Grade Water 的瓶中。

4. 卡盒储存箱应直立储存在 2 °C 至 8 °C 的冰箱中。

储存后准备卡盒
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• 如果卡盒未使用的时间超过一天，或者已长时间储存，则用 CE Grade Water 在 50 psi 的
压力下冲洗毛细管 5 分钟，以调节毛细管。

分析数据

分析 ssRNA Ladder 的数据

1. 在 32 Karat 软件中，从运行打开序列。

2. 打开第一个运行的数据文件。

3. 单击 File > Open > Method，选择分析 - RNA 9000 - ssRNA 梯，然后单击 OK。

作为参考，下面的图中显示了积分参数和命名峰表。

图 13 积分参数

注释: 峰名称与 ssRNA Ladder 中的 RNA 长度对应。

图 14 Named Peaks 表

4. 调整积分事件，直到测试样本中的所有峰都已正确积分。

请参阅文档《方法开发指南》中的“积分”一章。

5. 单击 File > Save 保存方法，然后将其应用于序列中包含 ssRNA Ladder 样本的行。
电泳图谱标记为 ssRNA Ladder 的成分对应的峰名称。
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图 15 ssRNA Ladder 的示例电泳图谱

制定接受度标准的要领

为了按照 SOP 与此试剂盒共用或其他目的而创建的接受度标准应基于体现关键样本质量的分
离和属性质量固有的参数。凝胶和毛细管批次之间的差异以及不同的系统可能会导致绝对迁移
时间的差异。

对于 ssRNA Ladder，9 kb 和 0.5 kb 峰的迁移时间之比更准确地反映了凝胶中的核酸的表观大
小，可用于确定分离凝胶的分辨率和分离的一致性。SCIEX 强烈反对使用绝对迁移时间作为
接受度标准。

故障排除

注释: SYBR™ 是 Life Technologies Corporation 的商标。SYBR™ Green II RNA Gel Stain 不
可转售。
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症状 可能的原因 纠正措施

宽峰、分辨率低 1. 毛细管末端受损。

2. 样本浓度过高。

3. 毛细管堵塞。

4. 毛细管的内表面被污染。

5. 已超过毛细管的使用寿命。

6. 凝胶缓冲剂中的 SYBR™

Green II RNA Gel Stain 浓度
过高。

1. 使用放大镜检查毛细管末端。
如果末端切割不平整，再次切
割或更换毛细管。

2. 执行下列操作之一或全部操
作：

• 使用样本稀释剂再次稀释样
本。

• 降低分离方法中的 Inject 事
件的 Duration 以减少进样
量。如果结果不能令人满
意，则降低 Pressure 或
Voltage。

3. 更换毛细管或毛细管卡盒。

4. 更换毛细管或毛细管卡盒。

5. 执行 ssRNA Ladder 测试分
离。如果峰宽一直比此前运行
中更宽，则更换毛细管或毛细
管卡盒。

6. 确保 SYBR™ Green II RNA Gel
Stain 在凝胶缓冲剂中稀释 100
倍到 1000 倍。请参阅以下章
节：装载缓冲剂托盘。

宽峰、分辨率低
（续）

1. Nucleic Acid Extended
Range Gel 保留在室温条件
下太久。

2. 毛细管卡盒保留在室温条件
下超过一周。

1. 制备新鲜的 Nucleic Acid
Extended Range Gel，确保将
其储存在 2 °C 至 8 °C 的环境
中。尽可能地减少凝胶处于室
温下的时间。

2. 更换毛细管或毛细管卡盒。对
于新毛细管，确保在每天结束
时运行关闭方法。
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症状 可能的原因 纠正措施

残留 1. 样本浓度过高。

2. 进样瓶或盖受到污染。

1. 执行下列操作之一或全部操
作：

• 降低分离方法中的 Inject 事
件的 Duration 以减少进样
量。如果结果不能令人满
意，则降低 Pressure 或
Voltage。

• 使用样本稀释剂再次稀释样
本。

2. 更换进样瓶和盖，或修改方
法：

• 向洁净的瓶中注入新制备的
试剂，给瓶盖上洁净的盖
子，然后更换托盘中的瓶。
切勿重复使用进样瓶或盖
帽。

• 确保废液瓶中含有 1.0 mL
水，且位于出口缓冲剂托盘
中。

• 在分离方法中，进样后添加
一个或多个水浸步骤。

额外的峰 1. 样本的非核酸成分与 SYBR™

Green II RNA Gel Stain 相互
作用。

2. 在样本制备过程中使用的塑
料制品或样本瓶被可与
SYBR™ Green II RNA Gel
Stain 相互作用的材料污染。

3. 凝胶缓冲剂中大于 1 μm 的颗
粒造成光散射。

1. 再次制备样本，确保样本纯
净。

2. 使用洁净的塑料制品和洁净的
样本瓶再次制备样本。切勿重
复使用进样瓶或盖帽。

3. 添加到缓冲剂托盘之前使用注
射器过滤器过滤凝胶缓冲剂。
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症状 可能的原因 纠正措施

电流过高 1. 凝胶缓冲剂被污染。

2. 缓冲剂托盘未正确设置。

3. Nucleic Acid Extended
Range Gel 保留在室温条件
下太久。

1. 使用洁净的瓶和盖更换当前瓶
和盖。 切勿重复使用进样瓶或
盖帽。

2. 确保缓冲剂托盘中的进样瓶含
有正确的试剂，且处于正确的
位置。请参阅以下章节：装载
缓冲剂托盘。

3. 制备新鲜的 Nucleic Acid
Extended Range Gel，确保将
其储存在 2 °C 至 8 °C 的环境
中。尽可能地减少凝胶处于室
温下的时间。

信号低 1. 毛细管尖端的末端脏污或堵
塞。

2. 样本浓度过低。

3. 样本中的盐浓度过高。

4. 初始核酸浓度过低。

1. 更换毛细管或毛细管卡盒。

2. 执行下列操作之一或全部操
作：

• 将分离方法中的 Inject 事件
的 Duration 增加至最多
15 s 以增加进样量。如果结
果不能令人满意，则升高
Pressure 或 Voltage。

• 使用推荐的浓度再次制备样
本。推荐的浓度为 50 ng/mL
至 50 μg/mL。

3. 执行下列操作之一或全部操
作：

• 如果分离方法使用电动力学
进样，则应使用压力进样。

• 制备离子强度较低的样本。

4. 执行下列操作之一或全部操
作：

• 将分离方法中的 Inject 事件
的 Duration 增加至最多
15 s 以增加进样量。如果结
果不能令人满意，则升高
Pressure 或 Voltage。

• 使用推荐的浓度再次制备样
本。推荐的浓度为 50 ng/mL
至 50 μg/mL。
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症状 可能的原因 纠正措施

信号低（续） 1. 由于存在 RNA 酶或其他核酸
酶，样本中的核酸已降解。

1. 再次制备样本，确保限制其与
RNA 酶的接触。请参阅以下章
节：处理 RNA 的最佳做法。

低电流 1. 毛细管尖端的末端脏污或堵
塞。

2. 毛细管窗口或末端破裂。

3. 电极、开口杆、毛细管端或
接口块上存在干燥的试剂。

4. 缓冲剂托盘未正确设置。

1. 更换毛细管或毛细管卡盒。

2. 检查毛细管窗口和尖端。如有
任何断裂，则应更换毛细管或
毛细管卡盒。

3. 每天清洁接口块，或根据需要
清洁。请参阅以下章节：清洁
接口块。

4. 确保缓冲剂托盘中的进样瓶含
有正确的试剂，且处于正确的
位置。请参阅以下章节：装载
缓冲剂托盘。

电流过低或不稳定 1. 毛细管尖端的末端脏污或堵
塞。

2. 凝胶缓冲剂中有气泡。

1. 更换毛细管或毛细管卡盒。

2. 对缓冲剂进行超声波处理 10 秒
到 20 秒，以除去气泡。

RNA 9000 Purity & Integrity 试剂盒

RNA 9000 Purity & Integrity 试剂盒 适用于 PA 800
Plus Pharmaceutical Analysis 系统
28/47

应用指南
RUO-IDV-05-13437-ZH-C



症状 可能的原因 纠正措施

分离期间无电流 1. 毛细管损坏。

2. 电极折断或弯曲。

3. 毛细管尖端的末端脏污或堵
塞。

4. 缓冲剂托盘未正确设置。

5. 毛细管中充满气泡。

6. 电极、开口杆、毛细管端或
接口块上存在干燥的试剂。

1. 更换毛细管或毛细管卡盒。

2. 更换电极。

3. 更换毛细管或毛细管卡盒。

4. 确保缓冲剂托盘中的进样瓶含
有正确的试剂，且处于正确的
位置。请参阅以下章节：装载
缓冲剂托盘。

5. 执行下列操作之一或全部操
作：

• 确保微型瓶中有 100 µL 的
样本。

• 确保缓冲剂托盘和样本托盘
中的进样瓶处于正确的位
置。请参阅以下章节：装载
缓冲剂托盘和装载样本托
盘。

• 对缓冲剂进行超声波处理
10 秒到 20 秒，以除去气
泡。

6. 每天清洁接口块，或根据需要
清洁。请参阅以下章节：清洁
接口块。
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症状 可能的原因 纠正措施

无峰 1. 已超过 LIF 检测器激光器的
使用寿命。

2. 方法参数不正确。

3. 样本瓶底部有气泡。

4. 毛细管窗口或末端破裂。

5. 样本量太少。

6. 样本缺失或未放在样本托盘
上的正确位置。

7. 使用 0.1 N NaOH 之类的碱
性溶液清洗毛细管。

8. 毛细管末端超出了电极。

1. 请通过 SCIEXsciex.com/
request-supportsciex.com/
request-support 技术支持人
员。

2. 执行以下操作：

a. 在软件中打开分离方法，
然后确保方法正确。请参
阅以下章节：分离方法。

b. 确保样本和试剂在托盘中
的位置与托盘布局一致。

3. 使用离心机旋转样本管到以确
保底部没有气泡。

4. 检查毛细管窗口和尖端。如有
任何断裂，则应更换毛细管或
毛细管卡盒。

5. 确保微型瓶中有 100 µL 的样
本。

6. 确保样本位于样本托盘上的正
确位置中。 请参阅以下章节：
装载样本托盘。

7. 更换毛细管或毛细管卡盒。

8. 使用放大镜检查毛细管末端。
如果末端超出电极，再次切割
末端或更换毛细管。

无峰（续） 1. 样本制备过程中发生了移液
错误。

2. 样本中的盐浓度过高。

1. 执行下列操作之一或全部操
作：

• 如果分离方法使用电动力学
进样，则应使用压力进样。

• 制备离子强度较低的样本。

2. 制备新样本。

迁移时间更长，有
或无并发低电流

1. 毛细管尖端的末端脏污或堵
塞。

1. 更换毛细管或毛细管卡盒。
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症状 可能的原因 纠正措施

同一天的运行之间
迁移时间大幅漂移

1. 毛细管未充分调节。

2. 凝胶缓冲剂已蒸发。

1. 调节毛细管。 请参阅以下章
节：调节毛细管。执行空白分
离运行以平衡毛细管表面。

2. 向洁净的瓶中注入新制备的试
剂，给瓶盖上洁净的盖子，然
后更换托盘中的瓶。切勿重复
使用进样瓶或盖帽。

电泳图谱中有尖峰 1. 凝胶缓冲剂中有气泡。 1. 对缓冲剂进行超声波处理 10 秒
到 20 秒，以除去气泡。 如果
气泡仍然存在，则制备新鲜的
凝胶缓冲液。切勿使用漩涡混
合器混合缓冲液，而应轻轻地
倒转试管至少 20 次。

宽峰或裂峰 1. 在变性步骤后，核酸样本仍
有二次结构。

2. 变性后的冷却步骤太慢。

3. 凝胶缓冲剂中的 SYBR™

Green II RNA Gel Stain 浓度
过高。

4. 已超过毛细管的使用寿命。

1. 使用 Sample Loading Solution
而非不含核酸酶的水稀释样
本。

2. 立即冷却样本以防止形成二次
结构。

3. 确保 SYBR™ Green II RNA Gel
Stain 在凝胶缓冲剂中稀释 100
倍到 1000 倍。请参阅以下章
节：装载缓冲剂托盘。

4. 执行 ssRNA Ladder 测试分
离。如果峰宽一直比此前运行
中更宽，则更换毛细管或毛细
管卡盒。

饱和峰 1. 在分离方法的 LIF Detector
Initial Conditions 中，
Dynamic range 太小。

2. 样本浓度过高。

1. 升高 Dynamic range 的值。

2. 执行下列操作之一或全部操
作：

a. 使用样本稀释剂再次稀释
样本。

b. 降低分离方法中的 Inject
事件的 Duration 以减少进
样量。如果结果不能令人
满意，则降低 Pressure 或
Voltage。
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症状 可能的原因 纠正措施

基线不稳定 1. 入口缓冲剂托盘中的染料浓
度与出口缓冲剂托盘中的浓
度不同。

1. 制备足够入口和出口缓冲剂托
盘使用的凝胶缓冲剂。
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有害物质信息 A
必须注意以下信息并采取相关安全措施。更多信息请参阅相应的安全数据表。这些安全数据表
可应请求提供，或者通过我们的网站 sciex.com/tech-regulatory 下载。

根据 HCS 2012 的危险等级分类。

Acid Wash/Regenerating Solution (0.1 M HCl)

危险! 造成严重皮肤灼伤和眼损伤。

SYBR™ Green II RNA Gel Stain4

警告! 可燃液体。导致皮肤刺激。

其他试剂

下列成分未分类为有害物质：

• CE Grade Water

• LIF Performance Test Mix

• Nucleic Acid Extended Range Gel

对于从其他供应商处获得的试剂，使用之前请阅读该供应商提供的安全数据表。

4 SYBR™ 是 Life Technologies Corporation 的商标。SYBR™ Green II RNA Gel Stain 不可转售。
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方法 B
毛细管调节方法

图 B-1 Initial Conditions 选项卡

方法
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图 B-2 LIF Detector Initial Conditions 选项卡

图 B-3 毛细管调节方法 Time Program 选项卡

方法
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分离方法

图 B-4 Initial Conditions 选项卡

图 B-5 LIF Detector Initial Conditions

方法
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图 B-6 电动力学进样的分离方法 Time Program 选项卡

关闭方法

图 B-7 Initial Conditions 选项卡

方法
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图 B-8 LIF Detector Initial Conditions 选项卡

图 B-9 关闭方法 Time Program 选项卡

方法
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毛细管冲洗方法

图 B-10 Initial Conditions 选项卡

图 B-11 LIF Detector Initial Conditions 选项卡

方法
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图 B-12 毛细管冲洗方法 Time Program 选项卡

方法
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校准 LIF 检测器 C
安装新毛细管或不同的卡盒之后，或者安装 LIF 检测器之后，校准 LIF 检测器。

试剂

• LIF Performance Test Mix

• Capillary Performance Run Buffer A

• CE Grade Water

1. 关闭 PA 800 Plus 系统，然后安装 LIF 检测器。

2. 开启 PA 800 Plus 系统，然后使激光器预热至少 30 分钟。

3. 打开 32 Karat 软件。

4. 单击 Tools > Enterprise Login，然后作为拥有管理权限的用户登录。

5. 单击 RNA 9000 仪器图标，然后右键单击 Configure > Instrument。
Instrument Configuration 对话框随即打开。

6. 单击 Configure。
PA 800 Plus System Configuration 对话框随即打开。

7. 在右侧窗格中，单击 LIF Detector 图标，然后单击右键并选择 Open。
PA 800 plus System Instrument Configuration 对话框随即打开。
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图 C-1 PA 800 plus System Instrument Configuration 对话框

8. 单击 LIF Calibration Wizard。

9. 执行校准。

a. 单击 Auto，然后单击 Next。

b. 在 Target RFU 字段中键入 40。
c. 确保 Capillary dimensions 区域中的值正确，然后单击 Next。
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图 C-2 Calibration Wizard - Step 2

10. 填充进样瓶，然后开始校准。

关于进样瓶位置，请参阅图：图 C-3。

a. 取一个通用瓶放在 Buffer 位置，填充 1.5 mL Capillary Performance Run Buffer A，
然后盖好瓶盖。

b. 取一个通用瓶放在 Calibration mix 位置，添加 1.5 mL 使用 CE Grade Water 按 1:1
稀释的 LIF Performance Test Mix，然后盖好瓶盖。

c. 取一个通用瓶放在 Waste 位置，填充 1.0 mL CE Grade Water，然后盖好瓶盖。

d. 单击 Next。
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图 C-3 Calibration Wizard - Step 3

当校准完成后，Calibration Wizard - Step 4 对话框随即打开。

11. 检查 Calibration Correction Factor 的值以评估结果。

• 如果数值小于 10，则校准成功。单击 Accept 保存结果并关闭校准向导。

• 如果数值大于 10，则单击 Cancel，然后请参阅以下章节：用于 LIF 检测器校准的
CCF 值。

图 C-4 Calibration Wizard - Step 4

12. 使用 Direct Control 将样本储存温度设置为 10 °C。

校准 LIF 检测器

RNA 9000 Purity & Integrity 试剂盒 适用于 PA 800
Plus Pharmaceutical Analysis 系统
44/47

应用指南
RUO-IDV-05-13437-ZH-C



用于 LIF 检测器校准的 CCF 值
报告的 CCF 值 措施

小于 0.1
或

系统性能不可接受

• 确保使用的是正确的毛细管且未断裂。

• 确保正在 PA 800 Plus 系统中使用的激光器的激光输出正确。

• 确保 LIF 检测器中安装了正确的过滤器。

• 激发：488 nm

• 发射：520 nm

• 更换测试混合物、缓冲剂和毛细管，然后重复校准。如果问题仍
然存在，请通过 sciex.com/request-support 联系 SCIEX 技术支
持人员。

0.1 到 10.0 系统没有问题。运行标准品，确保系统性能令人满意。

大于 10
或

系统性能不可接受

• 确保正在 PA 800 Plus 系统中使用的激光器的激光输出正确。

• 确保 LIF 检测器中安装了正确的过滤器。

• 激发：488 nm

• 发射：520 nm

• 更换测试混合物、缓冲剂和毛细管，然后重复校准。如果问题仍
然存在，请通过 sciex.com/request-support 联系 SCIEX 技术支
持人员。
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联系我们

客户培训
• 北美地区：NA.CustomerTraining@sciex.com

• 欧洲：Europe.CustomerTraining@sciex.com

• 在欧盟与北美之外请访问 sciex.com/education

在线学习中心
• SCIEX Now Learning Hub

购买用品和试剂
在 store.sciex.com 上在线重新订购 SCIEX 用品和试剂。要建立订单，使用报价、订单确认或
发货单中的帐号。目前，美国、英国和德国的客户都可以访问在线商店，将来会拓展至其他国
家/地区。对于其他国家/地区的客户，请联系当地的 SCIEX 代表。

SCIEX 支持
SCIEX 及其代表在全球范围内设有经过系统培训的服务和技术专家。他们可以解答系统问题
或可能出现的任何技术问题。详情请访问 SCIEX 网站 sciex.com 或通过下述方式之一联系我
们：

• sciex.com/contact-us

• sciex.com/request-support

网络安全
有关 SCIEX 产品的最新网络安全指南，请访问 sciex.com/productsecurity。

文档
本版本的文档取代本文档的所有先前版本。

要查看本文档的电子版本，需要 Adobe Acrobat Reader。要下载最新版本，请转到 https://
get.adobe.com/reader。

要查找软件产品文档，请参阅软件随附的版本发行说明或软件安装指南。

要查找硬件产品文档，请参阅系统或组件随附的文档。

最新版本的文档可从 SCIEX 网站上获得，网址：sciex.com/customer-documents。
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注释: 如需免费获取本文档的印刷版本，请联系 sciex.com/contact-us。
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